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SOFTWARE LICENSE 
 

THI S I S AN AGREEMENT BETWEEN YOU,  THE FI NAL USER,  AND NEURON LABS S. A.  DE C. V.  BY 
USI NG THI S SOFTWARE;  YOU ARE AGREEI NG TO BECOME BOUND BY THE TERMS OF THI S 
AGREEMENT.  
 
I F YOU DO NOT AGREE TO THE TERMS OF THI S AGREEMENT,  DO NOT USE THI S SOFTWARE.  
REMOVE I T FROM YOUR COMPUTER.  
 
GRANT OF LI CENSE:  
NEURON LABS,  AS LI CENSOR,  GRANTS TO YOU,  THE LI CENSEE,  A NON- EXCLUSI VE RI GHT TO USE 
THI S SOFTWARE PROGRAM ( THE " SOFTWARE" )  I N ACCORDANCE WI TH THE TERMS CONTAI NED I N 
THI S LI CENSE.   
 
OWNERSHI P OF SOFTWARE:  
NEURON LABS RETAI NS THE COPYRI GHT,  TI TLE AND OWNERSHI P OF THE SOFTWARE AND THE 
WRI TTEN MATERI ALS REGARDLESS OF THE FORM OR MEDI A I N OR ON WHI CH THE ORI GI NAL AND 
OTHER COPI ES MAY EXI ST.  
 
MODI FI CATI ON:  
YOU MAY NOT MODI FY,  REVERSE ENGI NEER,  DECOMPI LE,  OR DI SASSEMBLE THE SOFTWARE.   
 
TRANSFER:  
THI S SOFTWARE I S NOT TRANSFERABLE SI NCE THE REGI STRATI ON NUMBER THAT YOU RECEI VED 
WHEN YOU BOUGHT THE COPY CAN BE EXCLUSI VELY USED ON THE MACHI NE WHERE YOU I NSTALLED 
THE SOFTWARE.   
 
UNREGI STERED EVALUATI ON VERSI ON:  
PROVI DED YOU COMPLY WI TH ALL PROVI SI ONS OF THI S LI CENSE AGREEMENT YOU MAY FREELY 
USE THE UNREGI STERED VERSI ON OF THE SOFTWARE FOR ANY OF THE FOLLOWI NG:  

A.  YOUR PERSONAL,  PRI VATE USE 
B.  EVALUATI ON PURPOSES I N A BUSI NESS OR ORGANI ZATI ON FOR A PERI OD OF UP TO THREE 

( 3)  MONTHS 
C.  TO DEMONSTRATE THE SOFTWARE EI THER WI THI N YOUR ORGANI ZATI ON OR TO OTHER 

ENTI TI ES YOU MAY NOT USE THE UNREGI STERED EVALUATI ON VERSI ON WI THI N A 
BUSI NESS OR ORGANI ZATI ON EXCEPT AS EXPLI CI TLY ALLOWED FOR I N ( B)  OR ( C)  
ABOVE.  

 
REGI STRATI ON:  
THE SOFTWARE CAN BE REGI STERED WI TH NEURON LABS BY PAYI NG A REGI STRATI ON FEE PER 
EACH COPY THAT YOU WANT TO I NSTALL.  AFTER REGI STRATI ON THE ' UNREGI STERED EVALUATI ON 
VERSI ON'  CLAUSE SHALL NOT APPLY.  
 
LI MI TATI ON OF I NSTALLATI ON OF REGI STERED VERSI ONS:  
AFTER REGI STRATI ON YOU MAY I NSTALL THE REGI STERED VERSI ON OF CODEFORMS I N ONE 
COMPUTER.  YOU WI LL NEED TO BUY A LI CENSE FOR EACH COMPUTER WHERE YOU WANT TO 
I NSTALL CODEFORMS.  
 
TERMI NATI ON:  
THI S LI CENSE TERMI NATES AUTOMATI CALLY WI THOUT NOTI CE FROM NEURON LABS I F YOU FAI L 
TO COMPLY WI TH ANY PROVI SI ON OF THI S LI CENSE.  UPON TERMI NATI ON,  YOU SHALL REMOVE 
THE SOFTWARE FROM YOUR COMPUTER( S) .  NEI THER TERMI NATI ON NOR PAYMENT OF ANY 
REGI STRATI ON FEE ( S)  SHALL I N ANY WAY PREJUDI CE ANY RI GHTS THAT NEURON LABS HAS 
BECAUSE OF YOUR FAI LURE TO COMPLY WI TH ANY PROVI SI ON OF THI S LI CENSE AGREEMENT.  
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LIMITED WARRANTY 
 
 
THI S SOFTWARE AND ACCOMPANYI NG DOCUMENTATI ON ( I NCLUDI NG I NSTRUCTI ONS FOR USE)  ARE 
PROVI DED " AS I S"  WI THOUT WARRANTY OF ANY KI ND.  NEURON LABS DOES NOT WARRANT,  
GUARANTEE,  OR MAKE ANY REPRESENTATI ONS REGARDI NG THE USE,  OR THE RESULTS OF USE,  OF 
THE SOFTWARE OR DOCUMENTATI ON I N TERMS OF CORRECTNESS,  ACCURACY,  RELI ABI LI TY,  
CURRENTNESS,  SUI TABI LI TY OR OTHERWI SE.  
 
YOU ASSUME THE ENTI RE RI SK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE.  I F 
THE SOFTWARE OR WRI TTEN MATERI ALS ARE DEFECTI VE,  YOU,  AND NOT NEURON LABS OR I TS 
DEALERS,  AGENTS,  OR EMPLOYEES,  ASSUME THE ENTI RE COST OF ALL NECESSARY SERVI CI NG,  
REPAI R OR CORRECTI ON.  
 
NEURON LABS DI SCLAI MS ALL OTHER WARRANTI ES,  EI THER EXPRESSED OR I MPLI ED,  I NCLUDI NG 
BUT NOT LI MI TED TO THE I MPLI ED WARRANTI ES OF MERCHANTABI LI TY AND FI TNESS FOR A 
PARTI CULAR PURPOSE,  THAT I S MADE BY NEURON LABS,  ON THI S NEURON LABS PRODUCT.  
 
NO ORAL OR WRI TTEN I NFORMATI ON OR ADVI CE GI VEN BY NEURON LABS,  I TS DEALERS,  
DI STRI BUTORS,  AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR I N ANY WAY I NCREASE 
THE SCOPE OF THI S WARRANTY AND YOU MAY NOT RELY ON ANY SUCH I NFORMATI ON OR ADVI CE.  
YOU MAY HAVE OTHER RI GHTS WHI CH VARY FROM STATE TO STATE.  
 
NEI THER NEURON LABS NOR ANYONE ELSE WHO HAS BEEN I NVOLVED I N THE CREATI ON,  
PRODUCTI ON OR DELI VERY OF THI S PRODUCT SHALL BE LI ABLE FOR ANY DI RECT,  I NDI RECT,  
CONSEQUENTI AL OR I NCI DENTAL DAMAGES ( I NCLUDI NG BUT NOT LI MI TED TO DAMAGES FOR LOSS 
OF BUSI NESS PROFI TS,  BUSI NESS I NTERRUPTI ON,  LOSS OF BUSI NESS I NFORMATI ON,  AND THE 
LI KE)  ARI SI NG OUT OF THE USE OR I NABI LI TY TO USE SUCH PRODUCT EVEN I F NEURON LABS 
HAS BEEN ADVI SED OF THE POSSI BI LI TY OF SUCH DAMAGES.  
 
SHOULD ANY OTHER WARRANTI ES BE FOUND TO EXI ST,  SUCH WARRANTI ES SHALL BE LI MI TED I N 
DURATI ON TO NI NETY ( 90)  DAYS FOLLOWI NG THE DATE OF DELI VERY TO YOU.  I N NO EVENT 
WI LL NEURON LABS' S LI ABI LI TY FOR ANY DAMAGES TO YOU OR ANY OTHER PERSON EXCEED THE 
AMOUNT PAI D FOR THE LI CENSE TO USE THE SOFTWARE.  
 
THI S LI CENSE SHALL BE GOVERNED AND CONSTRUED I N ACCORDANCE WI TH THE LAWS OF MEXI CO,  
AND SHALL BENEFI T NEURON LABS,  I TS SUCCESSORS AND ASSI GNEES.   
 
THI S AGREEMENT CONSTI TUTES THE ENTI RE AGREEMENT BETWEEN YOU AND NEURON LABS.  
 

ACKNOWLEDGMENTS 
 

BY USI NG CODEFORMS YOU ACKNOWLEDGE THAT YOU HAVE READ THI S LI MI TED WARRANTY,  
UNDERSTAND I T,  AND AGREE TO BE BOUND BY I TS TERMS AND CONDI TI ONS.  YOU ALSO AGREE 
THAT THI S LI MI TED WARRANTY I S THE COMPLETE AND EXCLUSI VE STATEMENT OF AGREEMENT 
BETWEEN THE PARTI ES AND SUPERSEDES ALL PROPOSALS OR PRI OR AGREEMENTS,  ORAL OR 
WRI TTEN,  AND ANY OTHER COMMUNI CATI ONS BETWEEN THE PARTI ES RELATI NG TO THE SUBJECT 
MATTER OF THE LI MI TED WARRANTY.   
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How to Register CodeForms v4.0 
 
After you download  CodeForms from the internet, you will have a DEMO version of the product, the only 
difference between the DEMO copy and the REGISTERED copy is that with the DEMO version, you only will be 
able to create only 10x10 cm documents, which is enough to test all the features and power of the product. 
 
You can REGISTER your product by paying it, after you pay your copy, you will receive a REGISTRATION 
number which is unique for each copy of CodeForms and that will enable only that copy you have registered 
according the licence agreement. 
 
To register your copy of CodeForms, please follow these simple steps: 
 

1. Download your copy of CodeForms from: http://www.neuronlabs.com/cforms 
2. Run the installation software to setup CodeForms in your computer 
3. Run CodeForms and go to the Help Menu and select “Register CodeForms On-Line” 
4. The window in Figure A will come up. 
5. Click the link in step 2 to open the order form 
6. Select your payment method and follow the on-screen instructions, they will vary depending on the 

payment method you have choosen 
7. Click the link in step 3 to send us your Serial number 
8. The registration number delivery will be done once we validate your payment, it can take up to 6 hours. 
9. Once you receive the registration number, paste it in the appropriate box and click the “Register” button 

to enable your copy 
10. Close CodeForms and re-lunch it in order to activate all the features. 

 
 

 
 

Figure A. CodeForms Registration Form 
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What’s new on CodeForms v4.0 
 
CodeForms is the result of 7 years of hard work in my free time, It is the descendant of the now disscountinued 
Visual Documents v2.3. CodeForms it is not Visual Documents, Visual Documents was a tool that was born in 
our laboratory for internal purposes only, that is why it lacked of a lot of features and was not elegant at all. 
CodeForms is the commercial version of Visual Documents, it was rewritten 100% from scratch but keeping 
compatibility with the old version of Visual Documents to support customers that own any version of VDocs. 
 
I have made a lot of improvements, I won’t list’em all, I will only enumarate the most relevant ones: 
 

1. A totally new, beautiful and redesigned GUI was created. 
2. All the objects were rewritten for faster and easy manipulation. 
3. New objects were included, like the HTML Rendering Object which allows you to create beautiful HTML 

formatted documents or include ripped content from the web in your documents or reports in “realtime”, 
so you can have updated information at the time you, your customer or your boss print the document. 

4. With CodeForms now you can create documents so fast due its new template feature. 
5. More Intellicoders are now included, some of them will allow you to read CodeForms documents directly 

into your project, this way you can change the look and feel of your document without rewritting or  
recompiling a single line of your code again. 

6. A totally new Intellicoder editor was added, which colorizes the code at the time is being written for easy 
edition. 

7. A new and shinny HTML editor was also included, now you can edit HTML pages in a WYSIWYG 
environment or use HTML code to format your documents. 

8. A new RTF Editor was also included. 
9. The Preview window was also added, now you can take a look to the whole document or create 

screenshots of your project. 
10. New tools for better object manipulation were also added, among others you have the aligning, sizing, 

and object distribution tools. 
11. With CodeForms now you can modify your Intellicoders “OnTheFly”, this way you will be able to improve 

the Intellicoders faster for better results and better code. 
12. Projects now load faster thanks to its new file type (VD2). 

 
I have tried to fullfil all the improvment requests made by you, my customers, to give you a better product. I hope 
you enjoy it as much as I enjoyed creating it. If you find any bugs or need new features, please contact me, you 
will find my email in the About Form. 
 
Thank you for your interest in CodeForms 
Ing. Rafael Agundis Aguilera 
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Introduction 
 
 
What is CodeForms? 
 
As you know, writing Source Code to create printed documents with your programming projects is a tedious task, 
because it is a trial and error process, each string, line, picture or any other object that needs to be printed, must 
have a  (X,Y) cordinates to be printed in the right position of the paper sheet, at this moment the only way you 
can get an object in the right position of the sheet is by spending a lot of time, ink and paper doing tests until you 
get the right cordinates for each object.   
 
CodeForms has come to change all that and speed up this process, because now you can draw and desing your 
document in the CodeForms WYSIWYG editor and get in one step ready to use Source Code to simply copy it 
and paste it into your project, this means that the effort you made to print a document becomes reduced 
dramatically from several days to just several minutes. 
 
CodeForms is an Object-Oriented development tool that will improve your projects and their developing time, 
thus you will have more successful software and happier customers, it pays for itself many times over. 
 
 
Is CodeForms hard to use? 
 
CodeForms is designed to get you on your track right away, if you have used the Visual Studio R.A.D. or any 
other R.A.D. and Corel Draw, then you already know how to use CodeForms. Take a look to figure 1 and enjoy 
how easy is to create source code: 
 
 
 

 
 

Figure 1. Create Source Code in 3 easy steps 
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�

CodeForms Anatomy 
 
After you lunch CodeForms, you will see the window of Figure 2. 
 

 
 

Figure 2. CodeForms Main window 
 
What is what: 

1) Standard Menu. 
2) Tool Bars. 
3) Properties toolbar. 
4) Project Explorer. 
5) Panning Tool. 
6) WYSIWYG Development Area. 
7) View selection tabs. Used to switch between Document View, Intellicoder View and generated Source 

Code View or between html document and html source code or between rtf document and rtf source 
code. 

8) Color Palette. 
9) Interactive Zooming tool. 
10) Help Area. 
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Accelerator Keys  
 

CodeForms Accelerator Keys (FORM EDITION MODE) 
 
Some additional functionality and short cuts are provided by the following accelerator key combinations, which 
closely resemble the key combinations used for similar actions in other windows based applications. 
 

 
 
 

Keys Action 

CTRL-N Open the new project window 
F1 Show the Users Guide 
F2 Saves your project 
F3 Open a project 
SHIFT-F4 Closes current project 
CTRL-T Insert a template 
CTRL-P Prints the project 
CTRL-X Quits CodeForms 
CTRL-Z Undo the last operation 
CTRL-INS Copy Selected Objects 
SHIFT-INS Paste objects on clipboard 
CTRL-S Select all objects 
DEL Delete selected objects 
CTRL-F Autosize the selected objects 
F11 Enables ReadOnly Mode, click again to disable it 
L Align selected objects to left 
R Align selected objects to right 
C Align selected objects to Center 
T Align selected objects to Top 
B Align selected objects to bottom 
E Aligns selected objects to Middle 
V Distribute selected objects vertically 
H Distribute selected Objects horizontally 
CTRL-J Bring object to front 
CTRL-K Send Object to back 
LEFT ARROW Scrolls to the left 
RIGHT ARROW Scrolls to the right 
UP ARROW Scrolls Up 
DN ARROW Scrolls Down 
F5 Click to preview your project 
CTRL-UP ARROW Move all objects upwards 
CTRL-DN ARROW Move all objects downwards 
CTRL-LT ARROW Move all objects to the left 
CTRL-RT ARROW Move all objects to the right 
CTRL-D Clone selected objects 
CTRL-Y Cut selected objects 
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CodeForms Accelerator Keys (HTML EDITION MODE) 
 

 

CodeForms Accelerator Keys (SOURCE CODE EDITION MODE) 
 

 

CodeForms Accelerator Keys (RTF EDITION MODE) 
 

 
 
 
 

Keys Action 

CTRL-A Select All - Selects the entire document 
CTRL-P Print - Prints the current document 
CTRL-C Copy - Copies the current HTML selection onto the clipboard 
CTRL-X Cuts - Cuts the current HTML selection from the document and places it on the clipboard 
CTRL-V Paste - Paste the clipboard contents into the current cursor position in the document 
CTRL-B Bold - Bolds the current selection / word 
CTRL-I Italic - Italicizes the current selection / word 
CTRL-U Underline - Underlines the current selection / word 
CTRL-F Find – Opens the find dialog for text searching 
CTRL-Z Undo last operation 
SHIFT-ENTER HTML Break - Inserts an HTML BR element 
ENTER Starts a new HTML block element or inserts a BR element 
SHIFT-SPACE Insert a hard-space character 

Keys Action 

CTRL-A Select All - Selects the entire document 
CTRL-C Copy - Copies the current selection onto the clipboard 
CTRL-X Cuts - Cuts the current selection from the document and places it on the clipboard 
CTRL-V Paste - Paste the clipboard contents into the current cursor position in the document 
CTRL-Z Undo last operation 
CTRL-T Swap lines 
CTRL-I Insert a tab character 
CTRL-U Convert to lowercase 
CTRL-D Duplicate text row 

Keys Action 

CTRL-A Select All - Selects the entire document 
CTRL-C Copy - Copies the current selection onto the clipboard 
CTRL-X Cuts - Cuts the current selection from the document and places it on the clipboard 
CTRL-V Paste - Paste the clipboard contents into the current cursor position in the document 
CTRL-Z Undo last operation 
CTRL-I Insert two tab character 
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Creating a new project  
 
Let’s start by creating a new and 
blank project. 
 
From the CodeForms menu 
select ‘File’ and then ‘New 
Project’, as shown in Figure 3. 
 
The window in Figure 4 will come 
up requesting several options for 
the New Project. 

 
 

Figure 3. Creating a new Project 

 

 
 

Figure 4. New Project Dialog 

Follow this simple steps to create a project: 
 

1. Select the document’s orientation (portrait or 
landscape) 

2. Select the scale mode, by default CodeForms 
works in the metric system 

3. Select your project’s size, you can choose one 
on the list or set a custom size in the Width and 
Height boxes. 

4. Select the default programming language, this is 
the target language in which the source code will 
be created, the number of entries in the ‘Default 
programming language’ list will depend on the 
amount of intellicoders you have installed. An 
intellicoder is a script that will translate your 
document into the target language, they are 
written in VBScript and can be modified by the 
user to improve them or  you can write some of 
your own or download new ones from the 
internet.  

5. In the Project Name box, type the name for the 
new project. 

 
Click the ‘Create Project’ button located at the left-bottom corner to create the project, an empty sheet will be 
created in the CodeForms development area, and, a blank project with the name of your project will be created 
on disk. CodeForms creates one folder per document, the folder’s name will be the same as your project’s 
name, all the files needed by your project will be kept in this location automatically, so, if you erase one of the 
files in the folder, your project will problably get damaged. 
 
All your projects will be created in: 
 

C:\PATH WHERE YOU INSTALLED CODEFORMS\MYCODEFORMSPROJECTS\THE NAME OF YOUR PROJECT 
 
WARNING: If you create a new project with the name of an existing project, the new project will replace the old 
one, this means that all the files created for the previous project will be deleted and the folder will be clean and 
ready to store the files for the new project, so, if you need to reuse the project name, you will need to backup the 
previous project or rename it just in case you need your old project later. 
 
At this point you are ready to start drawing your form, report, or wherever you need to print. 
 
 



CodeForms v4.0 User’s Guide 

 

 
NEURON LABS 

 
http://www.neuronlabs.com 

 

 

13 

Basic Disk Operations  
 
Yes I now, all of us are great programmers and computer experts, it is not necessary to include these 
operations, but the users’s guide wouldn’t be complete without them. 
 

Saving your project 
 
 It is recommended as you are working on a project, to save it regularly to keep your progress on disk up to date. 
There are several ways to save your project: 
 

1. Goto the ‘File’ menu and select ‘Save project’, or 

2. Click  this icon  located at the left side of the toolbar in the first row of icons, or 
3. Press F2 in your keyboard 

 
The save dialog will come up requesting you the project’s name, click the ‘Save’ button and you will be prompted 
if you want to overwrite your project, click ‘Yes’ and your project will be stored on disk. 
 

Loading a project 
 
There are several ways to load a project: 
 

1. Goto the ‘File’ menu and select ‘Load project’ or 

2. Click  this icon  located at the left side of the toolbar in the first row of icons, or 
3. Press F3 in your keyboard 

 
The load dialog will come up, browse your disk to locate the project you want to load. You can load several 
projects at a time, and copy and paste components between projects. To switch from one project to another goto 
the ‘Window’ menu and select your project from the list. 
 

Closing a project 
 
To close a project, goto the ‘File’ menu and select ‘Close project’ or press shift-F4 from your keyboard. 
 

More Basic Operations 
 

Printing the project 
 

You can print a preview of your project by clicking this icon  or by selecting from the ‘File’ menu the ‘Print’ 
option. 
 

Quiting CodeForms 
 
To quit CodeForms selecto from the ‘File’ menu the ‘Exist CodeForms’ option or press Control-X from your 
keyboard. 
 

Recent files 
 
This option will track the last 3 documents that you opened recently, click on the file to open it at once. 
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Using Scanned Forms as templates  
 
One of the best CodeForms’ features, is that you can use scanned documents as templates, this means that you 
can  carbon-copy any document you or your customer already have, and that needs to be printed from your 
project, or you can use the scanned form to easily locate the cordinates to fill it up. 
 
To use an scanned document as a template you have to digitalize it first, follow this steps to scan a document: 
 

1. Select your scanner by clicking from the ‘File’ menu the ‘Select Scanner’ option or by clicking this icon 

 
2. A new dialog will appear listing all the available scanners in your system 
3. Select the desired scanner and press the ‘OK’ button, the appereance of this window will depend on  

your windows version. 
4. Once you have selected the scanner goto the ‘File’ menu and select ‘Scan Document’ or click this icon 

 
5. The scanner dialog will come up, the appereance and options on this window will vary depending on 

your scanner’s driver. 
6. Assuming you are scanning a letter sized sheet, scan the document to 100 DPIs this will give you the 

best ratio between the scanned document and your CodeForms project. 
7. Save the scanned document to disk 
8. Go again to the ‘File’ menu and select ‘Use an image as template’, browse your disk and locate the 

recently scanned form. 
9. The scanned document will be loaded behind all objects as show in Figure 5. 

 
 

 
 

Figure 5. Using a scanned document as template 
 
Now you can start to copy the document. 
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Using CodeForms templates  
 
CodeForms has some already made documents that you can use as templates, to create a new document from 
a template do this: 
 

1. Create a new project, if you don’t know how to do this goto the “create new project” section 

2. From the ‘File’ menu select ‘Use a CodeForms Template’ or click this icon  or press Control-T from 
your keyboard 

3. The templates window will come up as showin in Figure 6. 
4. Select the template by clicking once the entry in the directory tree at the right of the window 
5. Click the ‘Use this template’ button located at the right-bottom corner to insert the themplate in your 

project. 
6. Hold on a few secons while CodeForms creates the objects in your project. 

 
 

 
Figure 6.Creating projects from templates 

 
You can create your own templates to reuse them later, to create your own template do the following: 
 

1. Create a new project 
2. Draw your document template 
3. Press F5 to preview your document and click ‘Save preview’ located at the bottom of the window to 

create the template screenshot. 
4. Copy your project to the templates directory: 

 
 

Copy c:\codeforms\mycodeformsprojects\yourproject c:\codeforms\templates 
 
Next time you open the template window you will find there your template among the others. 
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Working with Objects 
 
The objects or controls are the CodeForms’s core, because the properties of these objects are used to make the 
translation between your project and source code. Each object has it’s own properties that are affected when 
you change them manually or when you alter the appearance or state of an object. You can create a new object 
by simply selecting the proper menu or by clicking the icons on the toolbar. CodeForms has the following 
objects: 
 
Object Icon Description 
Caption 

 
Used to insert fixed text in your projects, for instance the document’s title or the name 
of your company. 

Variable 
 

Used to insert variable text, for example, the date or the invoice number. 

ListBox 
 

It is used to print list or arrays of information, for instance a customer list. 

Line 
 

Used to draw lines. 

Rectangle 
 

Used to draw rectangles. 

Picture 
 

Used to insert images (BMP,JPG,GIF,WMF,EMF) 

Grid 
 

This object will create code to print any grid in your project, it used to create reports. 

RTFBox 
 

Used to print large amount of text like contracts 

Rotated Label 
 

Used to insert rotated text. 

Web Page 
 

Used to insert HTML formated text or a webpage or to rip the web content, for example 
the financial information published by yahoo daily. 

Function 
 

An specific function that you define, for instance, a function to insert the date in a 
specific format. 

 

Caption Control 
 
This object is used to create fixed text; this means the text that never changes in your document, for example, 
the name of the company or phone number, to create a Caption, goto the ‘Insert’ menu and select ‘Caption’ the 
new caption will be created at the top-left corner of the working area as you can see in the image below. 
 

 
 

At the moment that the caption object is created, 
the properties (shown at the left of CodeForms)  
will be set to their default values. 
 
To change the text that will be printed, do a click 
over the caption property and change it’s contents 
from ‘NEW CAPTION’ to wherever you want, for 
instance, ‘My Company Inc.’ and press ENTER on 
your keyboard to accept the new value, You will 
see how the text box in the working area is also 
changed. 
 
You can change all the properties the same way. 

If you want to change the fontype click this icon:  

If you want to change the color click this icon:   
 
To change the properties of a specific Caption, you 
have to select it first by clicking once over it. 
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With CodeForms it’s easy to know which object is selected because you will se two red boxes in the current 
object, one located at the top-left corner and one located at the bottom-right corner, the red box located at the 
top-left corner is used to move the object, you can also move the object by dragging over it, the red box located 
at the bottom-right corner is used to resize the object. 
 
All the properties work the same way except the font and color properties.  If you take a closer look, at the right 

of these properties, there are two buttons  and ; Click the buttons and new dialogs will appear, when you 
click the color button, the CodeForms’ Color Palette will be shown and when you click the font button, the font 
palette will be shown. Try to change the font type and the text color to see the results. 
 

Variable Control 
 
This object is used to create text that will change each time it is printed. For instance, the date, the time, the 
amount of a ticket, the customer name, etc. To create a new variable from the ‘Insert’ menu select the ‘Variable’ 
option, the variable object will be created at the top-left corner of the woriking area. 
 
Select the object and then take a look to the properties toolbar. Note 
that they are the same than the fixed text object, except in one field. 
Instead of caption field you have the variable field, on this field  you 
will have to type a valid variable name that will be associated with this 
object, for example: 
 
In VB: 

Cust omer $ 
For m1. Text box1. t ext  
Tr i m$( For m1. l i s t 1. l i s t ( For m1. l i s t 1. l i s t i ndex) )  
For mat ( dat e, ” MM- DD- YYYY” )  

In PHP: 
$MyVar i abl e 

 
These are valid values for the variable object. 

 
 
When you send this object to the printer, the variable name will be changed to the variable content. To learn 
more about this object, please read the Caption object section, except for the difference described above, they 
work the same way. 
 

ListBox Control 
 
This object is used to print arrays 
or lists boxes. Take a look to the 
generated source code because 
you will have to comment or 
uncomment a few lines 
depending on what you are trying 
to print.  
 
To create a new listbox, goto the 
‘Insert’ menu and select ListBox, 
the list will be filled with some 
sample data to show you how 
many lines will fit on the list’s 
space, see the example at the 
right. 
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Note that these controls also have their own control boxes, so you can move 
them and resize them the same way you did with  the caption and variable 
objects. If you are going to print more than one list box, it is convenient that 
you associate each control to the correspondent list or array in your project, 
it will be easier to understand the final generated source code; to do this, 
select the list to change by clicking on it, go to the properties toolbar and 
change the ‘Variable’ field to the name of the array or list box that you want 
to print, for example MyArrayName or Form1.List1. 
 
Remember once again: You will have to comment and uncomment a few 
lines depending on what you are going to print, a list box or an array, so 
please check the created source code for detailed information. 

 
All the properties work the same way except the font and color properties.  If you take a closer look, you will find 
out that you can also adjust the color and font properties the same way you did with the objects described 
earlier. Try to change the font type and the text color to see the results. 
 

Line Control 
 
These objects are used to create frames on your 
documents, they work basically the same way than the 
other objects described before. 
 
To create a line goto the ‘Insert’ menu and select ‘Line’, the 
line will be created at the top-left corner of the development 
area.  
 
Due the difference resolution between the printer and your 
screen, some times, when you create horizontal or vertical 
lines you will see them straight in your screen, but in paper 
they will have a slope, CodeForms take care of this by 
snapping horizontal and vertical lines to their proper axis, so 
make sure you drag enough the line to the proper axis to 
avoid this problem. 

 
 

Picture Control 
 
This control is very useful when you want to insert images in your documents, you can insert images in BMP, 
JPG, GIF or WMF formats. It is advisable to always use images in WMF format, if you have them available, 
because the information in this type of images is stored in a numerical way, this means that the image can be 
resized with out any quality loss. This will give your documents a more professional look. You can use different 
applications in the market like Corel Draw to create WMF files, but as we just mentioned, you can use any of the 
formats mentioned above. 
 
To insert a new image in your document, go to the ‘Insert’ menu and select the ‘Image’ option, the new image 
will be created at the top-left corner of the working area as show in figure 7. 
 
When a newly image is created, you will see the default picture, to load a picture. Go to the properties toolbar, 
and left-click over disk icon located at the right of the picture property (See figure 7) to show  the ‘Open dialog’ 
window, browse your disk to select the image that will be included in your project. 
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Figure 7. Loading a picture 

 
You can use Control-F to automatically resize the image after loading. 
 
After CodeForms creates the code to print this image, you can easily change it to print directly any image box in 
your project. You probably will have to do it because the generated source code will load the image by default 
from disk; to do this, take a look to the following example: 
 
 
If you are creating code in VB6, the original code created by CodeForms in VB will look like this: 

 
Pi ct ur esFRM. DocI MG( 1) . Pi ct ur e = LoadPi ct ur e( " C: \ MyPi ct ur e. WMF" )  

 
Altered  code by the programmer: 
 
 Pi ct ur esFRM. DocI MG( 1) . Pi ct ur e = For m1. Pi ct ur eBox1. Pi ct ur e 
 
 
NOTE:  If you are creating code in VB6, you will have to include this component to print the images: 
 

C:\PATH_TO_YOUR_CODEFORMS\SOURCE\PICTURESFRM.FRM 
 
 

Data Grid Control 
 
This powerful object is specifically designed to create REPORTS by printing any Microsoft FlexGrid control 
included in your project, this is very useful, because this control will print all the grid contents in one or more 
pages, enabling your project to print reports with any number of pages easily.   
 
When you are working with other report generators available in the market like Crystal Reports, you have to 
create the header and footer for your report and then, the content, with CodeForms you don´t need to do this 
because all the objects that surround the Data Grid Control will be printed on each page until all the grid content 
has been printed, this is a better way to create reports because you can work and see the real report design in 
the editor. 
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To create a new Data Grid Object, goto 
the ‘Insert’ menu and select ‘Data 
Grid’, the grid will be created at the 
top-left corner of the development 
area. It can only exists one Data Grid 
control per document. 
 
After creating the grid, you will see the 
new grid in the development area, this 
image represents the space and size 
occupied by the grid you want to print, 
take a look to figure 8. 
 
Next, go to the Properties toolbox and 
set the Grid property to the name of 
the grid that you want to print, for 
instance: 
 

f or m1. gr i d1 
 
or 
 

MyFor m. MyGr i d 
 

Figure 8. Creating a new Grid 

 
Combining the different printing objects of CodeForms, you will have reports with a more professional look that 
can easily compete with those generated with other tools like crystal reports. 
 
NOTE: If you are creating code in VB6, you will have to include this component in your project to print grids: 
 

C:\PATH_TO_YOUR_CODEFORMS\ SOURCE\GRIDFRM.FRM 
 

For other programming languages please read all the comments and instructions included in the generated 
source code to know which components you have to include in your project to make it work properly. 

 
RTF Box Control 
 
This control has been designed to print large amounts of 
text like contracts, licenses, agreements, etc. 
 
To insert a new RTF control goto the ‘Insert’ menu and then 
select the ‘RTF Box’ option. The new RTF object will be 
created at the top-left corner of the development area. At 
this point the RTF Box is empty, there are several ways to 
feed the text into your new RTF control, one way is to load 
an already made RTF document, another way is by editing 
the text directly in the CodeForms’ RTF Editor. 
 
Assuming that you already have the RTF document, Set 
the “RTF Box” property to create the relationship between 
the RTF box of your project with the RTF Box in 
CodeForms. Note that you have to include the name of the 
form as well as the name of the RTF box to make the 
relation, for example myform.myrtf, then use the RTF File 
property to select the file that will be printed. 
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To select the RTF file that will be loaded into the control click the disk icon  located at the right of the RTF File 
property, the Open Dialog will come up, browse your disk to select the file that you want to print. 
 
Assuming that you don’t have a RTF document and want to create one on the fly follow this steps: 
 

1) Create a new RTF object 
2) Set the RTF Box Property 

3) Click the Edit icon  located at the right of the RTF File property to enable the embedded RTF Editor 
4) The development area will switch to the CodeForms’ RTF Editor, at this point you won’t be able to see 

your project, don’t worry is still there. 
5) Note that toolbar located at the top of CodeForms will change, some icons will be enabled and other 

icons disabled as shown in Figure 9. 
 

 
Figure 9. Entering into the RTF Edition Mode 

 
Now you can start typing your text. There are several tools in the new enabled toolbar that will help you to format 
your text: 
 

Tool Description 

 
Clear the RTF Editor to start a new document 

 
Saves your RTF document 

 
Loads a RTF Document 

 
Prints the RTF document 

 
Apply changes and returns to the CodeForms’ Project editor 

 
UnDo changes 

 
Cuts selected text 

 
Copy Selected text 

 
Paste text from clipboard 

 
Deletes selected text 

 
Select all text 

 
Find a string 

 
Find next 
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Replace a string 

 
Bolds the current selection 

 
Italicizes the current selection 

 
Undelines the current selection 

 
Strikes the current selection 

 
Creates some bullets 

 
Left justifies the current selection 

 
Center justifies the current selection 

 
Right justifies the current selection 

 
Modifys / Sets the text font and size for the current selection 

 
Modifys / Sets the text color 

 
Uppercases current selection 

 
Lowercases current selection 

 
Another way to format a RTF document is by messing directly with the RTF code, your CodeForms’ copy has 
included the RTF description guide to write RTF code. To edit the RTF code click the SourceCode tab located at 
the bottom-right of the RTF Editor, instead of a nice formated code you will see the RTF code that you can 
modify. You can change your RTF document directly in the WYSIWYG edition mode or the RTF code in the 
Code edition mode, the result will be the same. 
 
To format text using the RTF format it is recommended that you take a look at the RTF description guide 
included with your copy of CodeForms. This guide is also accessible from the Help menu, this way, you will 
understand how to create formatted documents that can be filled or modified on the fly. For instance, if you want 
to create subscripts and superscripts with Greek symbols, you can write a code similar to this: 
 
  
{\rtf1 {\fonttbl {\f1\froman Times;}{\f2\ftech Symbol;}} 
{\plain \f1  
Rich Text example with Greek symbols, superscripts, underline and italics:\par } 
{\plain \f1 red}{\f2\up6 abg\par \par } 
{\plain \f1 blue}{\plain \f1\ul\up6 ln1}{\plain \f2\ul\up6 b\par} 
{\plain \f1 white}{\plain \i\f1\up10 rs[3]}{\plain \i\f2\up10 g\par} 
} 
 
The result is shown below: 
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Now, if you want to fill up your document with customized data or modify it on the fly, then you can use the 
REPLACE function included on VB6 or any equivalent function from your preferred programming language, for 
example: 
 
{\ r t f1 {\ font tbl  {\ f1\ froman Times;}{\ f2\ ftech Symbol;}} 
{ \plain \f1 My Customer name is: %CUSTOMER% \par }  
 
In your project you will do the following: 
 
1.  Load t he RTF code i nt o a var i abl e:  S=Myf or m. MyRTF. RTFText  
2.  Cust omi ze t he t ext :  S=r epl ace( S, ” %CUSTOMER%” ,  MyFor m. MyCust omer Name. Text )  
3.  Ret ur n t he RTF t ext  t o t he cont r ol :  Myf or m. MyRTF. RTFText  = S 
 
This way each time you change the text at MyForm.MyCustomerName.Text, the RTF code will be modified and 
printed with the modifications for the current customer. Please read all the comments in the generated source 
code to know which files you must include in your project to print RTF files. 
 
Take a look to the following sample that shows how to combine the standard CodeForms objects with the RTF 
box Object to create a professional looking document: 
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Web Page Control  
 
The Web Page Control is probably the best enhacement I have made to CodeForms, this control is designed to 
render a web page into a picture box, you can render either a full web page or just a portion of it allowing you to 
rip and print any web content or any HTML formatted document directly into your document in real time, it is 
specially usefull when you are trying to print HTML formatted tables or when you want to include web data in 
your report, for example the financial information provided by your Bank. 
 
To use this control go to the ‘Insert’ Menu and select ‘Web Page’, a new, blank and shinny web control will be 
created at the top-left corner of the development area, there are several ways to insert a HTML document in the 
web control: By typing the full URL to the document you want to render, by browsing your disk to load an already 
made HTML document or by editing a new document in the included HTML Editor. I will explain one by one.  
 

Using the Web Control to render an URL 
 
To render any web page from the internet, you have to set the value of three properties as shown below: 
 

 
 
The web page will be rendered once you have specified at least the URL and the filename of the picture. You 
must first provide the Picture’s file name in the LocalFile property and then the URL in the URLorFIle property 
and press <ENTER> in your keyboard to update the values. 
 
For instance: 
 
By Setting the LocalFile (the filename of the picture) property to “c:\mypic.bmp” and the URL property to 
http://www.yahoo.com, you will get the result shown below: 
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If you need only a portion of the web page, you must use the OffsetX and OffsetY properties to move the origin 
of the web page inside the Web Box Control and then resize the Web Control to enclose the desired portion of 
the web page, for example: 
 

 
 
 
Now each time you print your document with your software you will have on paper the updated weather 
information, cool! isn’t it? 
 

 
Using the Web Control to render a local HTML file 
 
This is very simply, the only thing you have to do is set the LocalFile property and then, click over the disk button 

( ) located at the right of the URLorFile property and finally browse your disk to select the file you want to 
render. 
 
 

Using the Web Control to render a document created with the embedded 
HTML Editor 
 
Assuming that you don’t have a HTML document and want to create one on the fly follow this steps: 
 

1) Create a new Web Box object 

2) Click the Edit icon  located at the right of the URLorFile property to enable the embedded HTML 
Editor 

3) The development area will switch to the CodeForms’ HTML Editor, at this point you won’t be able to see 
your project, don’t worry is still there. 

4) Note that toolbar located at the top of CodeForms will change, some icons will be enabled and other 
icons disabled as shown in Figure 10. 
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Figure 10. Entering into the HTML Edition Mode 

 
Now you can start creating your HTML document.  
 
Once you have finished your HTML document, you will have to save it, CodeForms won’t render any document if 

it doesn’t have a file name. To save your HTML document click this button  located at the HTML Edition 
Toolbar., then you have to tell CodeForms that you want to insert the HTML you just created into your 

CodeForms project, this can be achived by clicking this button  located at the right of the URLorFile property 
or at the HTML edition toolbar, you will be asked to confirm the operation, click ‘Yes’ and your HTML document 
will be rendered into the CodeForms Editor. 
 
For more information on how to edit HTML documents using the CodeForms embedded HTML editor, please 
read the ‘Editing HTML Documents with CodeForms” section. 
 

Rectangle Control 
 
These objects are used to create frames on your documents, they work basically the same way than the other 
objects described before. To create a Rectangle goto the ‘Insert’ menu and select ‘Rectangle’, the Rectangle 
Dialog Box will be displayed as shown in Figure 15. The rectangle dialog box will let you create 3 types of 
rectangles, a wireframe rectangle, a solid rectangle and a gradiented rectangle, you can change the color and 
the gradient’s angle by sliding the scrollbar. 
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Figure 15. The Rectangle Dialog Box. 

 
 
Once you have made the propper adjustments, click the ‘Insert my Rectangle’ button located at the left-bottom 
corner of the windows and the rectangle will be created at the top-left corner of the development area.  

 
Rotated Text Control 
 
These objects are usefull when you need to include text in a different angle in your project, to insert a rotated 
label, goto to the ‘Insert’ menu and select the ‘Rotated Label’ option, a new window will come up that will let you 
design and preview your label as shown below: 
 

 
 
 

At the top of this window, there is a text box labeled ‘Type your Text’, in this box type in the text you want to 
rotate, then choose the font type, size and color,  once you get the text in the desired style, select the 
orientation, you will see how your text becomes rotated according the angle you have selected, clik the button 
‘Insert my Tag’ located at the bottom-left corner of this window and your text will be rendered into the 
CodeForms Editor as shown in Figure 16. 
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NOTE:  You can not re-edit this text, If you need to make changes you will have to delete the previous tag and 
create a new one.  
 

 
Figure 16. Rotated text 
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Object Edition  
   
CodeForms es equipped with several tools to help you create your projects faster, some of them are the 
standard edition tools and some other are specific for CodeForms. You can access all these tools by selecting 
the proper menu option or by using the Accelerator Keys listed in page 9 of this user guide. 
 
 
Edit Menu 
 

Icon Tool Description 

 
UnDo Undoes the last operation. 

 
Cut Cuts selected objects to clipboard 

 
Copy Copies selected objects to clipboard 

 
Paste Paste Clipboard contents 

 Select All Selects all objects in project 

 Delete Delete selected objects 

 Resize Enables/Disables autoresize property 

 Read Only Locks all objects. 

 
Bring to front Brings selected object to front 

 
Send to back Send selected object to back 

 
Align to Left Aligns selected objects to left 

 
Align to Center Aligns selected objects to Center 

 
Align to Right Aligns selected objects to Right 

 Align to Top Aligns selected objects to Top 

 
Align to Middle Aligns selected objects to Middle 

 Align to Bottom Aligns selected objects to bottom 

 Resize Width Resizes selected objects to the same width 

 Resize Height Resizes selected objects to the same height 

 Resize W&H Resizes selected objects to the same width and height 

 Distribute Horizontally Distributes selected objects horizontally 

 Distribute Vertically Distributes selected objects vertically 

 Snap Horizontal Snaps selected objects horizontally 

 Snap Vertically Snaps selected objects Vertically 

  
 
Multiple Objects Selection 
 
There are two ways to select multiple objects, the first one is by holding the <Control> Key and aclik on each 
object that you want to select; the second one is by enclosing the objects in the selection tool by dragging the 
mouse over the development area while holding the left mouse button, The object will be included in the 
selection if its left top corner is inside the selected area, in the next page you will find a graphic example of how 
to select multiple objects. 
 



CodeForms v4.0 User’s Guide 

 

 
NEURON LABS 

 
http://www.neuronlabs.com 

 

 

30 

 
 
Please note that once you release the mouse button, the selected objects will be enclosed by a green box. 
 
Resizing Multiple Objects 
 
You can resize multiple objects by dragging over the Green Control box located at the bottom-right of the 
selected area. 
 
Moving Multiple Objects 
 
To move all enclosed objects at once, it will be enough if you move one of them, the rest of the selected objects 
will follow you. 
 
Please note that if you want to move the objects to a non visible portion of the development area, it will be 
anough to move the mouse to the edge in the needed direction, CodeForms will detect this movement and will 
scroll the development area automatically. 
 
Unselecting Objects 
 
To unselect and object, click in a blank portion of the development area, if you have several objects selected and 
want to exclude one or more objects, hold the <Control> key and click over the object you want to exclude. 
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Creating Source Code 
 
Once you have finished your document it is recommended to take a look to the entire project to make you sure 
that everything is correct, to preview your entire design, go to the ‘Project’ menu and select ‘Preview Document’ 
you will see the window shown below with a thumbnail of your project, you can switch between several view 
options according the printer you have installed by clicking the buttons located at the bottom of the preview 
window. 

 
 
Now that you have approved your design, all you have to do is to create the source code; CodeForms comes 
equipped with several converters or Intellicoders to translate your design into source code, the inlcuded 
Intellicoders are: 
 
Intellicoder: Function: 
A list to view the properties of all objects This will show you how to access all the CodeForms 

objects and their properties. 
Code in C # to print the document This will create C#.NET source code to print the document 
Code in Delphi to print the document This will create Pascal source code for Delphi or Kylix 
Code in Visual Basic 6 to print the document This will create sourcecode in Visual Basic 6 to print the 

document 
Code in Visual Basic NET to print the document This will create sourcecode in Visual Basic.NET to print 

the document 
Create Visual Basic 6 Source Code to print the 
document and read the object values from a VDP 
file 

This will create sourcecode in Visual Basic 6 to print the 
document but the values will be taken from the VDP file 
that you specify, this is cool because you won’t have to 
recompile your project to modify the document. 

Code in PHP to create a PDF document This will create PHP source code to print the document to 
a PDF file 

Code in JAVA to print the document This will create JAVA source code to print the document 
 
To convert your design to source code, go to the ‘Project’ menu, click in the ‘Compile to..’ option and select the 
desired Intellicoder,  CodeForms will switch automatically to the Source Code Editor where you can copy or save 
the resulting code to include it directly into your project. 
 
NOTE: Please read carefully the comments included in the resulting source code because they will let you know 
which files you will need to include into your project to work propperly. 
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Editing HTML Documents with CodeForms 
 

Basics of HTML 
 
HTML – Hyper Text Markup Language. HTML is authoring language of the World Wide Web. HTML defines the 
structure and layout of a Web document by using a variety of markup tags and attributes. These tags and 
attributes instruct programs like web browsers, such as Internet Explorer, Mozilla and CodeForms, how to layout 
and display  documents written in HTML such as those retrived from the world wide web. 
 
The correct structure for an HTML document starts with <HTML><HEAD></HEAD> and then <BODY> and ends 
with </BODY></HTML>. All the information you©d like to display in a HTML Document fits in between the 
<BODY> and </BODY> tags. For example: 
 
<HTML> 

<HEAD> 
(what the document is about) 

</HEAD> 
<BODY> 

(what is displayed in the web browser or CodeForms) 
</BODY> 

</HTML> 
 
There are hundreds of other tags used to format and layout the information in a Web page. Tags are also used 
to specify images to display in web pages and hypertext links.  
 

What does the CodeForms HTML Editor do? 
 
The editor is WYSIWYG ( What You See Is What You Get ) HTML Editor. Its function is to allow the user of 
CodeForms to edit and create HTML Markup in a visual design mode, similar to a word processor, minimizing 
the necessity for the user to have any HTML coding knowledge and, to provide an editable visual preview of the 
HTML document before publishing it to the CodeForms Document Editor. 
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The Toolbar 
 
There are several tools in the new enabled toolbar that will help you to format your web page: 
 
 
 

Tool Description 

 
Clear the HTML Editor to start a new document 

 
Saves your HTML document 

 
Loads a HTML Document 

 
Prints the HTML document 

 
Apply changes and returns to the CodeForms’ Project editor 

 
UnDo changes 

 
Cuts selected text 

 
Copy Selected text 

 
Paste text from clipboard 

 
Left justifies the current selection 

 
Center justifies the current selection 

 
Right justifies the current selection 

 
Bolds the current selection 

 
Italicizes the current selection 

 
Undelines the current selection 

 
Strikes the current selection 

 
Ident text 

 
Outdent text 

 
Modifys / Sets the text font and size for the current selection 

 
Enumerate items 

 
Insert bullets 

 
Insert a picture 

 
Insert a link (usless since you can not browse the net in paper) 

 
Insert a table 

 
Insert an horizontal line 
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Right Click Context Menus 
 
The editor contains some right-click context-menus that allow direct access to the selected objects properties. 
When a user performs a right-click after selecting either an image, a Table border, a hyperlink, or standard text 
the following context menus are displayed.  
 
Context-Menu Images 
 
Right Clicking on a previously selected Image displays the images context menu shown in Figure 11. Cut , Copy 
, and Paste have the same clipboard functionality as standard windows applications.  
 

 
Figure 11. Context-Menu Images 

 
By double-clicking over the image, you will get the image properties form shown in Figure 12. 
 
 

 
Figure 12. Image properties Form 
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Where: 
 

Width - the width of the image in pixels. 
 
Height - the height of the image in pixels. 
 
Constrain Proportions - when selected changing the value of one dimension of the image will cause 
the other to recalcuate as to maintain the images original aspect ratio. 
 
Reset - will return the image to its actual width and height in pixels. 
 
Source - the URL of the image. This may be edited if you would like to change the image. 
 
Border - the width of the border displayed around the image in pixels. 
 
Align - The images alignment in relation to the surrounding text. 
 
Alt Text - The text displayed in a browser that doesnt show images and the text displayed when 
hovering the mouse over an image in other browsers. 

 
Context-Menu Tables 
 
Selecting and then Right Clicking on a table border displays the context menu shown below: 
 

 
 
 
Where: 
 

Insert Row - Inserts a Table Row to the bottom of the table. 
 
Delete Row - Deletes the bottom row from the table. 
 
Insert Column - Inserts a new column to the right-hand side of the table. 
 
Delete Column - Removes the right-most column from the table. 
 
Note - To perform advanced row and cell operations use the DOM Toolbar menus for the individual rows and cells 
 
Properties - opens the table properties form. 
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By clicking the Properties option, in the contex-menu, you will get the Table Properties Form, shown in figure 13. 
 

 
Figure 13. Table Properties Form 

Where: 
 

Border Width - the tables© Border Width in pixels. 
Border Colour – Border Colour, clicking the paint bucket icon opens the standard windows colour 
picker. 
Background Colour - Background Colour, clicking the paint bucket icon opens the standard windows 
colour picker. 
Cell spacing - Cell Spacing between the tables individual Cells. 
Width - The table width as a pixel value or as a percentage of its parent HTML element. 
Style - A valid CSS style string describing the table properties. 

 
Context-Menu Text 
 
Right Clicking on a link or section of a text element displays 
 
Cut, Copy and Paste - behave the same way windows 
cut, copy and paste clipboard functions do. In the case 
of a hyperlink both the text and link are copied, cut or 
pasted. 
 
Insert / Edit Link - Opens the link editing form, which 
is not worth to explain since you can not have links in 
paper. 

 
Figure 14. Context-Menu Text 
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The Document Object Model ( DOM ) Toolbar 
 
Overview 
 
The Document Object Model ( DOM ) Toolbar provides an easy way to select HTML elements between the root 
of the document ( the <BODY> tag ) and the currently selected element. The DOM “branch” is essentially a 
listing of each parent HTML element from the selected element back to the <BODY> tag. This enables the user 
to modify the properties of any HTML element or it’s parent, or it’s grand-parent , or it’s great-grandparent etc etc 
in a branch of the HTML DOM.  
 
For Example by clicking on a link inside a table cell inside which is in a table row in a table will produce the 
following display on the DOM Toolbar: 
 

 
 
Graphically, it can be represented like this: 
 

 
 
 

Typing “Some more Text” into cell 3 on row 2 and aligning to the center using the  button and then clicking in 
then text will change the DOM toolbar to: 
 
TABLE – TR – TD – P 
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Graphically, it looks like this: 
 

 
 
Each section of the DOM Toolbar behaves as a button, clicking on an section will produce a context menu 
allowing access to the properties, HTML tag code, CSS class, and in the case of table cells and table rows, 
some more advanced functionality. 
 
DOM Toolbar Context Menus 
 
For Images 
 

 

Properties – Opens the standard IMG tag properties window. Identical to 
right-clicking an image and selecting properties. 
Edit Tag – Allows editing of the HTML IMG tag that defines the image 
Class – Opens the CSS subclass menu, selecting a CSS style from the 
sub-menu applies the rules defined for that class to the image element 

 
For TD (table cell ) Elements 
 

 
 

Properties – Opens the Cell Properties windows. 
Edit Tag – unavailable for table cell elements. 
Class – Opens the CSS subclass menu, selecting a CSS style from the 
sub-menu applies the rules defined for that class to the HTML element 
Cell Sub-menus 

·  Delete Cell – removes the selected cell. 
·  Merge Cell Left – Merges the contents of the selected cell and the 

contents of left-hand cell adjancent into one cell. 
·  Merge Cell Right - Merges the contents of the elected cell and the 

contents of Right-hand cell adjancent into one cell. 
·  Insert Cell Before – Inserts a cell to the left of the current cell. 
·  Insert Cell After – Inserts a cell to the right of the current cell. 

 
 
For TR (table row ) Elements 
 

 

Properties – Opens the Cell Properties window. 
Edit Tag – unavailable for table cell elements 
Class – Opens the CSS subclass menu, selecting a CSS style from the 
sub-menu applies the rules defined for that class to the HTML element 
Row Sub-menus 

·  Delete Row – removes the selected row and its child elements. 
·  Insert Row Above – Inserts a row above the selected row. 
·  Insert Row Below – Inserts a row below the selected row. 
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For TABLE Elements 
 

 

Properties – Opens the Table Properties window. 
Edit Tag – Allows editing of the opening HTML tag that defines the 
element. 
Class – Opens the CSS subclass menu, selecting a CSS style from the 
sub-menu applies the rules defined for that class to the HTML element. 

 
For All Other HTML Elements 
 

 

Properties – at present a properties form is unavailable for other elements. 
Edit Tag – Allows editing of the opening HTML tag that defines the 
element. 
Class – Opens the CSS subclass menu, selecting a CSS style from the 
sub-menu applies the rules defined for that class to the HTML element. 
 

 
CSS Classes 
 
A Brief Overview 
 
Cascading style sheets (CSS) address many of the problems of old-style HTML. Some of the older tags, 
especially the notorious <FONT>, clutter Web page source code and make for inflexible sites. With CSS, style 
information can be centralized. This centralization leads to increased power and flexibility. 
 
With cascading style sheets, designers are able to use tags to reference a style rather than redescribe it for each 
HTML element they wish to stylise. Then, when a style needs to be changed, only the referenced declarations 
need to be changed, not all of the instances where it is used. 
 
CSS information may be contained on each Web page, called from an external file, or both. For sites with many 
style declarations, the centralized method (external file) offers the most potential efficiency gains in terms of site 
management. 
 
Using Style Sheet Styles in the Editor 
 
The CodeForms HTML Editor supports Cascading Style Sheets, either as external files or as rules defined in the 
document itself. Selecting the “Class” menu item from the DOM Toolbar popup menu allows any of the CSS 
styles defined in a document to be applied to the element selected. 
 
For Example 
 

 

The selected <P>, or paragraph tag, can have any of 
the listed style sheet styles applied to it. 
 
Currently the HTML of the tag is: 
 
<P align=center>Some more text</P> 
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Clicking on the listHeader style in the CSS menu 
changes the CSS style of the <P> tag to listHeader. 
 
The HTML of the <P> tag now is: 
 
<P align=center class=listHeader>Some more text</P> 
 

 

Selecting none from the CSS menu removes the 
“class” attribute from the <P> tag. 
 
The HTML of the <P> tag now reads: 
 
<P align=center>Some more text</P> 
 

 
To customize the options shown in the style sheet menu go to the directory where CodeForms is installed and 
edit the file defualt_html_style.css, the datailes of how to write CSS files are beyond the scope of this book. 
 
Selection Highlighting 
 
The editor can be set to display selection highlighting. HTML elements can be highlighted are clicks on the 
document itself and / or on the DOM toolbar. Highlighting is in the form of a border draw around the selected 
element. 
 
For example: 
 
A <SPAN> selected An <IMG> selected A <P> selected 

   
 
After saying all this, I have to tell you that you can also edit your HTML document using HTML tags, to do this 
click the SourceCode tab located at the bottom-right of the HTML Editor, instead of your HTML document you 
will see the HTML code that you can modify on the fly. You can change your HTML document directly in the 
WYSIWYG edition mode or in the Code edition mode, the result will be the same. To switch to the SourceCode 
Edition mode you have to uselect all the objects in the HTML Editor. 
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Intellicoders  
 

What is an Intellicoder? 
 
Intellicoder becomes from Intelligent Coder, it is a Script written in VBScript that is in charge of doing the 
translation between your design and source code, take a look to Figure 17, they are fully updateable by the 
CodeForms’ users, or you can write new ones and sell them over the net, basically they allow you to translate 
the project designed in the development area to virtually anything you need, they are the CodeForm’s core, this 
is a powerfull concept. 
 

 
Figure 17. Translation process 

 
Intellicoders are stored in the following directory: 
 

C:\PATH TO YOUR CODEFORMS\INTERPRETERS 
 

They must have the .VBS extention in order to be recognized by CodeForms as a translator. 
 
When you start CodeForms, it will look inside this directory for all the intellicoders that you have installed, and 
then, they will be added to the ‘Compile to…’ menu located at the ‘Project’ menu. 
 
To get access to an intellicoder, press the ‘Intellicoder’ tab, located at the bottom-right of the development area, 
you will see how the intellicoder source code is shown, if you are an experienced programmer you can easily 
modify the intellicoder to get better results. 
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Creating Intellicoders 
 
The first thing you have to do to create an Intellicoder, is to enable the CodeForms’ Source Code Editor, this can 
be achived by clicking the ‘Intellicoder’ tab located at the bottom-right of the Development area, or by selecting 
from the ‘Project’ menu the ‘Create or Edit Intellicoder’ option. Again, you will see how CodeForms enables and 
disables some toolbars as shown bellow: 

 
 
The Toolbar 
 
There are several tools in the new enabled toolbar that will help you to format and edit your source code: 
 

Tool Description 

 
Clear the Source Code Editor to start a new Intellicoder 

 
Saves your Intellicoder 

 
Loads an Intellicoder 

 
Prints the Source Code 

 
UnDo changes 

 
Cuts selected text 

 
Copy Selected text 

 
Paste text from clipboard 

 
Deletes selected text 

 
Select all text 

 
Ident 

 
Outdent 

 
Find String 

 
Find Next 

 
Replace String 

 
Goto a specific line number 

 
Create a Dialog Box 

 
Runs the Intellicoder 
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To create or edit an Intellicoder you will also need to have some knowledge on VBScript programming. I will give 
you the just the basics to help you understand how to write an intellicoder, but if you want to learn more, it will be 
better for you to download a VBScript tutorial from the internet, there are plenty of them. 
 
What is VBScript? 
 
VBScript is a Basic-like language that many popular applications like Microsoft Outlook, Internet Explorer and 
many developer products like CodeForms use. VBScript descends from Visual Basic for Applications (VBA), 
which is the language Visual Basic (VB) and Microsoft Office products rely on. Although Microsoft initially 
designed VBScript as a scripting language for the Web, VBScript has become a popular language for writing 
Windows-oriented batch files through the Windows Scripting Host (WSH). With WSH, the Windows OS treats a 
VBScript file as an executable—in other words, like a batch (.bat) or executable (.exe) file. As a result, you can 
use VBScript©s rich and powerful functions and syntax to compose our beloved Intellicoders. 
 
WSH consists of a Windows-based host (wscript.exe), a console-based host (cscript.exe), the WSH object 
model (wshom.ocx), the VBScript scripting engine (vbscript.dll), and the JScript scripting engine (jscript.dll). Both 
wscript.exe and cscript.exe work as a runtime engine that manages and executes VBScript files. The WSH 
object model is a runtime library of built-in COM objects. The presence of COM is an important aspect of WSH 
and VBScript. Because VBScript can create an instance of, or instantiate, COM objects, WSH©s extensibility has 
no limits. As a result, you can write scripts that access any system feature and that provide any kind of behavior. 
CodeForms uses all this power, because the VBScript engine parses and executes any intellicoder, the result of 
this event is the source code derivated from your design. 
 
Declaring Variables 
 
VBScript©s syntax includes many elements. Three important elements are variables, constants, and types. A 
variable is an item that holds data that can change during a script©s execution, whereas a constant is an item that 
holds data that can©t change during a script©s execution. You classify the data that variables and constants hold 
into types. For example, long integer numbers are a type called Long, double-precision floating-point values are 
a type called Double, and text is a type called String. 
 
When you use VBScript, you©re not required to explicitly declare your variables; if you don©t declare your 
variables, you can©t declare their type. However, implicit declaration (declaration that automatically occurs when 
you use a variable in a script) is a potential source of bugs because typing errors typically go undetected until a 
problem arises. To prevent such problems, you can add the Option Explicit command at the top of your script. 
The Option Explicit command forces the runtime engine to accept only those variables you explicitly declare. If 
you use a variable that you haven©t declared, you receive an error message. You can declare variables with any 
of these commands:  
 
   Di m x 
   Di m x, y 
   Pr i vat e x, y 
   Publ i c  x, y, z 
 
You must use the Public and Private commands at the beginning of a script; you can use Dim statements at any 
point. Variables that you declare at the script©s start are script-level declarations that apply to all the subroutines 
and functions in a script. Variables that you declare within a subroutine or function are procedure-level 
declarations that apply only to that local subroutine or function. 
 
Notice that the Dim, Private, and Public statements don©t include the As qualifier. In VBScript, you can©t explicitly 
declare types. If you use a statement such as Dim y As Long in your VBScript code, you©ll receive an Expected 
end of statement error because the VBScript parser won©t understand the additional information that the As 
qualifier contains. After a Dim, Private, or Public statement, VBScript expects to find a comma followed by 
another variable declaration, a colon followed by a statement, or a line return specifying the end of the 
statement. 
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The lack of a type declaration doesn©t mean that VBScript doesn©t support types. Rather, VBScript considers all 
variables the same type: Variant. The parser manages all the variables through the generic Variant type. If 
Microsoft had designed VBScript so that you had to explicitly declare types, the parser would©ve had to perform 
extensive type checking. Unlike compiled languages, VBScript performs all syntax and type checks during 
runtime. Thus, VBScript©s assumption that all variables are the Variant type saves the parser a great deal of 
time. 
 
Getting your Source Code 
 
CodeForms uses the vdSource variable to store the source code generated by your intellicoder, this way you 
can have the resulting source code colorized and nicely formatted inside the CodeForms’ source code editor. 
Let’s write a small intellicoder that will show you how this works: 
 
Sub Mai n( )  
 VdSour ce=” MsgBox ” +chr $( 34) +” Thi s i s  my f i r s t  I nt el l i coder ” +chr $( 34)  
End Sub 
 
Porting this to CodeForms would look like this: 
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Please note that all Intellicoders must start with the Sub Main() declaration, which means that is the main routine 
and must be executed first. 
 
Another important thing is that doublequotes (“) can not be included inside the VBScript instruction, so they must 
be replaced by the chr(34) statement. 
 
Creating Loops 
 
"For ... Next" is probably the most commonly used loop statement in VB. Here is its syntax:  
    
For  l oop_var i abl e = i ni t i al _val ue To f i nal _val ue [ St ep i nt er val ]  
      s t at ement _bl ock ( mul t i pl e st at ement s)  
Next  
 
Where "loop_variable" is a temporary variable used to control the loop, "initial_value" is the initial value to be 
assigned to the loop variable, "final_value" is the upper bound to stop the loop, and "interval" is the interval that 
controls how the loop variable to be updated at each iteration. Note that if "interval" is not specified, "1" will be 
used as the interval.  
 
If you want to know exactly how the "For ... Next" statement will be executed, here is my understanding:  
 
Step 1: "intial_value" is assigned to "loop_variable".  
 
Step 2: Comparing the current value of "loop_variable" against the "final_value".  
 
Step 3: If the current value of "loop_variable" is less than or equal to the "final_value", continue with Step 5.  
 
Step 4: If the current value of "loop_variable" is greater than the "final_value", terminate the loop.  
 
Step 5: Execute "statement_block" enclosed in the "For ... Next" loop.  
 
Step 6: Update the "loop_variable" with the current value plus the "interval"  
 
Step 7: Continue with Step 2.  
 
Note that the above description is based positive "interval". If "interval" is a negative value, the termination 
condition will be "the loop variable value is less than the final value.  
 
If you want to terminate the loop early, you can use the "Exit For" statement, which will terminate the loop 
immediately.  
 
For instance: 

 
This script will instruct CodeForms to print five times the command MsgBox “Hello World” in the output Source 
Code window, one per row.  The CrLf are the CARRIAGE RETURN and LINE FEED characters, and must be 
included each time you need a new row  in the resulting code. 
 
The For…Next loop will be your best friend when creating Intellicoders. 

VBScript Code: Result: 
DI M S 
S=” ”  
Cr Lf =chr ( 13) +chr ( 10)   
For  I =1 t o 5 
    S=S+” MsgBox ” +chr $( 34) +” Hel l o Wor l d” +chr $( 34) +Cr Lf  
Next  
VDSour ce=S 

MsgbBox “ Hel l o Wor l d”  
MsgbBox “ Hel l o Wor l d”  
MsgbBox “ Hel l o Wor l d”  
MsgbBox “ Hel l o Wor l d”  
MsgbBox “ Hel l o Wor l d”  



CodeForms v4.0 User’s Guide 

 

 
NEURON LABS 

 
http://www.neuronlabs.com 

 

 

46 

Accesing the CodeForms’s Objects 
 
All the CodeForms’s Objects and their properties can be easily accessed from the Intellicoder’s editor, this way 
you can read the status, position, color and all the properties of each object. 
 
The following table will show you the available properties for each object: 
 
CodeForms’ Object VBScript Object Properties 
Caption vdlabel Caption: Holds the text string that will be printed 

Top: The top cordinate of the string 
Left: The left cordinate of the string 
Width: The String Width 
Height: The String Height 
ForeColor: The Color for that string given in RGB 
Font Type: The Font type (Make sure you include the font in 
your project’s installer) 
Font Size: The Font Size 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

Variable vdVariable Caption: Holds the text string that will be printed (Variable 
property) 
Top: The top cordinate of the string 
Left: The left cordinate of the string 
Width: The String Width 
Height: The String Height 
ForeColor: The Color for that string given in RGB 
Font Type: The Font type (Make sure you include the font in 
your project’s installer) 
Font Size: The Font Size 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

ListBox vdList Tag: Holds the list or array to be printed (Variable property) 
Top: The top cordinate of the listbox 
Left: The left cordinate of the listbox 
Width: The listbox Width 
Height: The listbox Height 
ForeColor: The Color for that listbox given in RGB 
Font Type: The Font type (Make sure you include the font in 
your project’s installer) 
Font Size: The Font Size 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

Line vdLine Top: The top cordinate of the line 
Left: The left cordinate of the line 
Width: The line’s Width 
Height: The line’s Height 
BorderColor: The Color for that line given in RGB 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 
X1=Top, Y1=Left 
X2=Left+Width-30, Y2=Top+Height-30 
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Continued… 
CodeForms’ Object VBScript Object Properties 
Rectangle vdRectangle Top: The top cordinate of the Rectangle 

Left: The left cordinate of the Rectangle 
Width: The Rectangle’s Width 
Height: The Rectangle’s Height 
BorderColor: The Color for that Rectangle given in RGB 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

Image vdImage Top: The top cordinate of the image 
Left: The left cordinate of the image 
Width: The image’s Width 
Height: The image’s Height 
Tag: The filename of the image to load (Picture) 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

Web Page vdHTMLBox Top: The top cordinate of the Web Page 
Left: The left cordinate of the Web Page 
Width: The Web Page’s Width 
Height: The Web Page’s Height 
Oname: The web page object name inside your project 
OutputFileName: The name of the image that will be used to 
save the rendered page 
URLorFile: The web page you want to print 
OffsetX: The horizontal displacement of the web page 
OffsetY: The vertical displacement of the web page 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

Data Grid vdGrid Tag: The grid of your project that you want to print (Grid) 
Top: The top cordinate of the grid 
Left: The left cordinate of the grid 
Width: The grid’s Width 
Height: The grid’s Height 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

RTF Box vdTextBox Tag: Holds the file name of the RTF File to print (RTF File) 
ToolTip: Holds the name of the RTFbox that the user wants to 
print. (RTFBox)  
Top: The top cordinate of the grid 
Left: The left cordinate of the grid 
Width: The grid’s Width 
Height: The grid’s Height 
Visible: If visible=false the object was deleted else you must 
create code for that object 
Ubound: Holds the number of objects of this type 

 
NOTE: The difference between Caption and Variable is  that the Caption will print the text in the caption property 
and the Variable will print the content of the variable. For example: 
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By sending vdlabel.Caption=Hello to the printer will print the word Hello 
By sending vdVariable.Caption=Hello to the printer will print the content of the Hello variable 
 
Now that you have learned all the objects and their properties available to write intellicoders, I will give you an 
example of how to access them using the For..Next statements. 
 
 
 
Sub Mai n( )    
    MsgBox " THI S SAMPLE DEMOSTRATES HOW TO ACCESS CODEFORMS OBJECTS"   
    DI M I      
    Cr Lf =chr ( 13) +chr ( 10)   
  
    ' Accessi ng t he Text  boxes  
    sour ce = sour ce + " ' LABELS"  + CHR( 13)  + CHR( 10)   
    FOR I  = 1 TO vdLabel . Ubound  
 ' I f  t he obj ect  i s not  v i s i bl e i t  means i t  was del et ed  

i f  vdl abel ( i ) . v i s i bl e t hen  
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Capt i on = "  + vdLabel ( i ) . Capt i on + Cr Lf   
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Font  = "  + vdLabel ( i ) . Font  + Cr Lf   
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Font Si ze = "  + cst r ( vdLabel ( i ) . Font si ze)  + Cr Lf         

sour ce = sour ce + " Label "  + cst r ( i )  + " . Col or  = &H"  + hex( vdLabel ( i ) . For ecol or )  + Cr Lf  
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Top = "  + cst r ( vdLabel ( i ) . Top)  + Cr Lf  
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Lef t  = "  + cst r ( vdLabel ( i ) . l ef t )  + Cr Lf   
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Wi dt h = "  + cst r ( vdLabel ( i ) . Wi dt h)  + Cr Lf  
       sour ce = sour ce + " Label "  + cst r ( i )  + " . Hei ght  = "  + cst r ( vdLabel ( i ) . Hei ght )  + Cr Lf   
       sour ce = sour ce + Cr Lf  

       end i f   
    next   
  
    ' Accessi ng t he Var i abl e Boxes  
    sour ce = sour ce + " ' VARI ABLES"  + Cr Lf  
    FOR I  = 1 TO vdVar i abl e. Ubound  
 ' I f  t he var i abl e i s not  v i s i bl e i t  means i t  was del et ed  
 i f  vdVar i abl e( i ) . Vi s i bl e t hen  

       sour ce = sour ce + " Var "  + cst r ( i )  + " . Name = "  + vdVar i abl e( i ) . Capt i on + Cr Lf   
       sour ce = sour ce + " Var "  + cst r ( i )  + " . Font  = "  + vdVar i abl e( i ) . Font  + Cr Lf   
       sour ce = sour ce + " Var "  + cst r ( i )  + " . Font Si ze = "  + cst r ( vdVar i abl e( i ) . Font si ze)  + Cr Lf         

sour ce = sour ce + " Var "  + cst r ( i )  + " . Col or  = &H"  + hex( vdVar i abl e( i ) . For ecol or )  + Cr Lf  
       sour ce = sour ce + " Var "  + cst r ( i )  + " . Top = "  + cst r ( vdVar i abl e( i ) . Top)  + Cr Lf  
       sour ce = sour ce + " Var "  + cst r ( i )  + " . Lef t  = "  + cst r ( vdVar i abl e( i ) . l ef t )  + Cr Lf  
       sour ce = sour ce + " Var "  + cst r ( i )  + " . Wi dt h = "  + cst r ( vdVar i abl e( i ) . Wi dt h)  + Cr Lf   
       sour ce = sour ce + " Var "  + cst r ( i )  + " . Hei ght  = "  + cst r ( vdVar i abl e( i ) . Hei ght )  + Cr Lf   
       sour ce = sour ce + Cr Lf   
end i f   

    next   
  
    ' Accessi ng t he Li st Boxes  
    Sour ce = Sour ce + " ' Li st s"  + Cr Lf   
    For  i  = 1 To vdLi st . Ubound  
 ' i f  t he Li st box i s not  v i s i bl e t hen i t  was del et ed  
 i f  vdLi st ( i ) . v i s i bl e t hen  

 Sour ce = Sour ce + " Li st "  + Cst r ( i )  + " . Name = "  + vdl i st ( i ) . t ag + Cr Lf   
        Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Font  = "  + vdLi st ( i ) . Font  + Cr Lf   

Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Font Si ze = "  + CSt r ( vdLi st ( i ) . Font Si ze)  + Cr Lf        
Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Col or  = &H"  + Hex( vdLi st ( i ) . For eCol or )  + Cr Lf   

       Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Top = "  + CSt r ( vdLi st ( i ) . Top)  + Cr Lf  
       Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Lef t  = "  + CSt r ( vdLi st ( i ) . Lef t )  + Cr Lf   
        Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Wi dt h = "  + CSt r ( vdLi st ( i ) . Wi dt h)  + Cr Lf   
        Sour ce = Sour ce + " Li st "  + CSt r ( i )  + " . Hei ght  = "  + CSt r ( vdLi st ( i ) . Hei ght )  + Cr Lf         

Sour ce = Sour ce + Cr Lf  
 end i f   
    Next   
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    ' Accessi ng t he Li nes  
    Sour ce = Sour ce + " ' Li nes"  + Chr ( 13)  + Chr ( 10)   
    For  i  = 1 t o vdLi ne. Ubound  
 ' i f  t he l i ne i s not  v i s i bl e,  t he i t  was del et ed by user   
 i f  vdl i ne( i ) . v i s i bl e t hen  
   Sour ce = Sour ce + " Li ne"  + Cst r ( i )  + " . X1 = "  + Cst r ( vdLi ne( i ) . Lef t )  + Chr ( 13)  + Chr ( 10)   
   Sour ce = Sour ce + " Li ne"  + Cst r ( i )  + " . Y1 = "  + Cst r ( vdLi ne( i ) . Top)  + Chr ( 13)  + Chr ( 10)   
   Sour ce = Sour ce + " Li ne"  + Cst r ( i )  + " . X2 = "  + Cst r ( vdLi ne( i ) . Lef t +vdLi ne( i ) . Wi dt h- 30)  + Cr Lf  
   Sour ce = Sour ce + " Li ne"  + Cst r ( i )  + " . Y2 = "  + Cst r ( vdLi ne( i ) . Top+vdLi ne( i ) . Hei ght - 30)  + Cr Lf   
   Sour ce = Sour ce + " Li ne"  + Cst r ( i )  + " . Col or  = &H"  + Hex( vdLi ne( i ) . Bor der Col or )  + Cr LF 
   Sour ce = Sour ce + Cr LF 
 end i f   
    next   
     
    ' Accesi ng t he r ect angl es  
    Sour ce = Sour ce + " ' Rect angl es"  + Chr ( 13)  + Chr ( 10)   
    For  i  = 1 t o vdRect angl e. Ubound  
 ' I f  r ect angl e i s not  v i s i bl e,  t hen i t  was del et ed by user   
 i f  vdRect angl e( i ) . Vi s i bl e t hen  

Sour ce = Sour ce + " Rect angl e"  + Cst r ( i )  + " . Top = "  + Cst r ( vdRect angl e( i ) . Top)  + Cr Lf     
Sour ce = Sour ce + " Rect angl e"  + Cst r ( i )  + " . Lef t  = "  + Cst r ( vdRect angl e( i ) . Lef t )  + Cr Lf   
Sour ce = Sour ce + " Rect angl e"  + Cst r ( i )  + " . Wi dt h = "  + Cst r ( vdRect angl e( i ) . Wi dt h)  + Cr Lf     
Sour ce = Sour ce + " Rect angl e"  + Cst r ( i )  + " . Hei ght  = "  + Cst r ( vdRect angl e( i ) . Hei ght )  + Cr Lf     
Sour ce = Sour ce + " Rect angl e"  + Cst r ( i )  + " . Col or  = &H"  + Hex( vdRect angl e( i ) . Bor der Col or )  + Cr Lf  
sour ce = sour ce + Cr Lf  

 end i f   
    next   
  
    ' Accessi ng t he i mages  
    Sour ce = Sour ce + " ' I MAGES"  + Chr ( 13)  + Chr ( 10)   
    For  i  = 1 To vdI mage. Ubound  
 ' I f  t he i mage i s not  v i s i bl e,  t he i t  was del et ed  
 I f  vdI mage( i ) . Vi s i bl e t hen  

        Sour ce = Sour ce + " I mage"  + CSt r ( i )  + " . I mageFi l e = "  + vdI mage( i ) . Tag + Cr Lf   
        Sour ce = Sour ce + " I mage"  + CSt r ( i )  + " . Top = "  + CSt r ( vdI mage( i ) . Top)  + Cr Lf   
        Sour ce = Sour ce + " I mage"  + CSt r ( i )  + " . Lef t  = "  + CSt r ( vdI mage( i ) . Lef t )  + Cr Lf   
        Sour ce = Sour ce + " I mage"  + CSt r ( i )  + " . Wi dt h = "  + CSt r ( vdI mage( i ) . Wi dt h)  + Cr Lf   
        Sour ce = Sour ce + " I mage"  + CSt r ( i )  + " . Hei ght  = "  + CSt r ( vdI mage( i ) . Hei ght )  + Cr Lf   
        Sour ce = Sour ce + Cr Lf   

 end i f   
    Next   
  
    ' Accessi ng t he HTMLBoxes  
    Sour ce = Sour ce + " ' HTML Boxes"  + Cr Lf   
    For  i  = 1 To vdHTMLBox. Ubound  
 ' I f  t he i mage i s not  v i s i bl e,  t he i t  was del et ed  
 I f  vdHTMLBox( i ) . Vi s i bl e t hen          

Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . Out Put Fi l eName = "  + vdHTMLBox( i ) . Out Put Fi l eName +Cr Lf    
Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . URLor Fi l e = "  + vdHTMLBox( i ) . URLor Fi l e + Cr Lf   
Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . Top = "  + CSt r ( vdHTMLBox( i ) . Top)  + Cr Lf   
Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . Lef t  = "  + CSt r ( vdHTMLBox( i ) . Lef t )  + Cr Lf   
Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . Wi dt h = "  + CSt r ( vdHTMLBox( i ) . Wi dt h)  + Cr Lf  
Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . Hei ght  = "  + CSt r ( vdHTMLBox( i ) . Hei ght )  + Cr Lf   
Sour ce = Sour ce + " WebBox"  + CSt r ( i )  + " . OName = "  + CSt r ( vdHTMLBox( i ) . OName)  + Cr Lf   
Sour ce = Sour ce + Cr Lf   

 end i f   
    Next   
 
    ' Accessi ng t he Gr i d  
    Sour ce = Sour ce + " ' Gr i d"  + Cr Lf   
    For  I  = 1 t o vdGr i d. ubound  
 ' i f  t he gr i d i s not  v i s i bl e t he i t  was del et ed by t he user   
 i f  vdGr i d( i ) . v i s i bl e t hen  
   Sour ce = Sour ce + " Repor t "  + CSt r ( i )  + " . Name = "  + vdGr i d( i ) . Tag + Cr Lf   
   Sour ce = Sour ce + " Repor t "  + CSt r ( i )  + " . Top = "  + CSt r ( vdGr i d( i ) . Top)  + Cr Lf   
   Sour ce = Sour ce + " Repor t "  + CSt r ( i )  + " . Lef t  = "  + CSt r ( vdGr i d( i ) . Lef t )  + Cr Lf   
   Sour ce = Sour ce + " Repor t "  + CSt r ( i )  + " . Wi dt h = "  + CSt r ( vdGr i d( i ) . Wi dt h)  + Cr Lf   
   Sour ce = Sour ce + " Repor t "  + CSt r ( i )  + " . Hei ght  = "  + CSt r ( vdGr i d( i ) . Hei ght )  + Cr Lf   
   Sour ce = Sour ce + Cr Lf   
 end i f   
    next   
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    ' Accessi ng RTF Boxes  
    Sour ce = Sour ce + " ' RTF Boxes"  + Cr Lf   
    For  I  = 1 t o vdText Box. ubound  
   Sour ce = Sour ce + " Text Box"  + Cst r ( i )  + " . Fi l e = "  + vdText Box( i ) . Tag + Cr Lf   
   Sour ce = Sour ce + " Text Box"  + Cst r ( i )  + " . Name = "  + vdText Box( i ) . Tool t i pText  + Cr Lf   
   Sour ce = Sour ce + " Text Box"  + Cst r ( i )  + " . Top = "  + Cst r ( vdText Box( i ) . Top)  + Cr Lf   
   Sour ce = Sour ce + " Text Box"  + Cst r ( i )  + " . Lef t  = "  + Cst r ( vdText Box( i ) . Lef t )  + Cr Lf   
   Sour ce = Sour ce + " Text Box"  + Cst r ( i )  + " . Wi dt h = "  + Cst r ( vdText Box( i ) . Wi dt h)  + Cr Lf   
   Sour ce = Sour ce + " Text Box"  + Cst r ( i )  + " . Hei ght  = "  + Cst r ( vdText Box( i ) . Hei ght )  + Cr Lf   
   Sour ce = Sour ce + Cr Lf   
    next   
  
    vdSour ce = sour ce  
End Sub  
  
If you didn’t undersand how to write an intellicoder, today is your lucky day, because I have included several 
intellicoders in the CodeForms’s installer for the most widely used programming languages, so, under normal 
programming circumnstances you won’t have to deal with them. 
 
Saving you Intellicoder 
 

Once you have finished your intellicoder you can test it by pressing this icon , if you get the correct source 

code, then is time to save your intellicoder, this can be achived by pressing this icon , please don’t forget to 
save the intellicoder to C:\PATH TO YOUR CODEFORMS\INTERPRETERS, otherwise you won’t be able to run 
it from the compile menu. 
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The Color Palette 
 
The CodeForms’s color palette is one of the most advanced palettes on the market. It will allow you to create 
virtually any color you want. To reach the color palette, first you have to create an object, then try to change it’s 
color, you will see the basic color palette: 
 

 
 
At the bottom of the color palette, you have 3 check boxes that will allow you to switch between different palette 
styles. Those styles are: Hue palette, the Saturation palette and the bright palette as you can see in the following 
picture: 
 

   
 
Click on the mixer button located at the middle right of the palette to display the color mixer: 
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The first option you have at the top of the mixer is the default color palette or fixed colors palette, these colors 
will always be the same. 
 
The second option you have, is the color mixer, use this tool to create and test new colors: 
 

 
 

And the third option is the color converter, use this tool to find equivalents between color systems: 
 

 
 
The RGB Long and the RGB Hex fields in this option can be used directly in Visual Basic. 
 
You can define your own color palette by pressing the 
‘Preset’ button located at the right of the basic color 
palette. 
 
To define a new color, you will have to select one of the 
black boxes, then use the mixer to choose the appropriate 
color. After you selected  the color, click  the ‘<<Add’ 
button to include it in your presets. 
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The color picker 
 

 

Use this tool to steal any color on the screen. First you have to click over the dropper and drag 
the mouse over the color of the screen that you want to import. As you drag the mouse all over 
the screen,  you will see how the ‘Current color box’ changes to the chosen color, release the 
mouse button to select the color. 
 

 
Current color sample located at the right-top of the basic color palette 
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Other Tools 
 

The panning trackball  
Once you have finished your document, it is probably that you will have to make 
small adjustsments, if you do, you can use this control adjust all object’s position, 
drag over the trackball and you will see how the objects go from one place to 
another.  
 
You can adjust the step size, it can be one pixel, one centimeter or one inch, or you 
can customize the values. 
 
Be careful, because if you select a large step, your objects can go out of the working 
area. 

 
  

The project explorer  
 

 

Use this tool to select or locate an object, it is specially usefull when one or more 
object have fallen outside the development area, just select the object and adjust 
the properties to return the object to the correct position. 

 

The Ruler 
 
To show the rulers, go to the ‘View’ menu and select  the ‘Rulers’ option, you will see how the rulers are show in 
the development area as shown bellow: 
 

 
 

You can change the ruler’s darkness factor by clickng with the right mouse button over the development area. 
 

Darker <<   >> Ligther 
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Measurement Tools 
 

 

CodeForms comes also equipped with  the following advanced measuring tools: 
Length, Slope, Angle, Perimeter and Area. These tools are useful when you are 
trying to create complex documents with lots of controls that have to fit in a 
predefined space. 

 
Description Check the results of the measuring in this window The tool 

Length:  
 
Press Control-F1 to make 
the ruler appear, drag 
over the yellow dots to 
move and resize the 
ruler. 

 

 

Slope: 
 
Press Control-F2 to make 
the slope tool appear, 
move the yellow dots to 
change the slope. 

 

 

Angle: 
 
Press Control-F3 to show 
the angle tool, move the 
yellow dots to change the 
angle. 

 

 

Perimeter: 
 
Press Control-F4 to show 
the perimeter tool. Click 
around the area you want 
to measure. A yellow dot 
will appear after each 
click. You can move the 
dots later to correct the 
measure. 
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Area: 
 
Press Control-F5 to 
activate the area tool. 
Click around the area 
that you want to measure 
and check the window for 
the results. You can  
move the yellow dots 
later to make corrections 
to the measurement. 

 

 

 
Zooming Tool 
 
The zooming tool will help you to locate the right cordinates for your objects, as soon as you select and object, 
the zooming tool will start to zoom the area around the cursor, you can change the zoom factor by scrolling the 
vertical scrollbar located at the left of the zooming tool. 
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Tips & Tricks 
 

Now I will give you some Tips & Tricks that will be useful when you are developing with CodeForms: 
 

Justifying Text in the HTML Editor 
 

1. Insert a Web Page Control 
2. Enable the HTML Editor 
3. Insert a table 
4. Set the table width to a fixed value to avoid table autosizing 
5. Type the text inside the cell 
6. Select the text 
7. Select the Center justifying button 
8. Unselect the text 
9. Click over the SourceCode tab to get the HTML code 
10. Change the tag <P align=center> to <P align=justify> 
11. Return to the HTML WYSIWYG edition mode and your done. 

 

Creating dynamic HTML Documents 
 

1. Create a HTML document with customized tags i.e: 
<t abl e><t r ><t d>Name: </ t d><t d>%%CUSTOMER%%</ t d></ t r ></ t abl e> 

2. Save the HTML document 
3. In your preferred programming language insert a form 
4. In the new form insert the HTML Web page control 
5. Insert all the required fields and text boxes that will be filled by the end user, i.e. FormMain.Customer 
6. Once the end user clicks the Print button do the following: 
7. Open the html document and load the code in a variable i.e. HTMLCODE 
8. Use the replace function or an equivalent to set the %%CUSTOMER%% tag to the content of 

FormMain.Customer.Text for example: 
HTMLCODE=REPLACE( HTMLCODE, ” %%CUSTOMER%%” , For mMai n. Cust omer . Text )  

9. The resulting HTML code contained in HTMLCODE will be: 
<t abl e><t r ><t d>Name: </ t d><t d>The Cust omer  Name</ t d></ t r ></ t abl e> 

10. Save the new HTML code 
11. Load the HTML Document into the Web page control 
12. Print the document, this will give you a nice formatted table with dynamic content. 
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My Final Comments 
 
Well, I guess thats all you need to use CodeForms, after all the hard work I have made over the past seven 
years to develop this software to improve your developing time, your businness and your live, It will be fair that 
you improve mine by buying a copy of this software, I really enjoyed writting it and I hope you enjoy using it. 
 
Thank you for downloading CodeForms and reading this guide. 
 
Rafael  Agundis A. 
ragundis@neuronlabs.com 
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